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Warranty

Trademarks

MiroCam®, MiroView™, IntroMedic, and the associated logos are the
registered trademarks ® or trademarks ™ of IntroMedic Co., Ltd. © IntroMedic
Co., Ltd. July 2007.

Except as required by applicable copyright laws; any use of the IntroMedic
trademarks, or any reprinting, reproduction, modification, referencing and
translations of the User Manual, without the prior written approval of
IntroMedic Co., Ltd. is strictly prohibited.

Warranty

Every effort has been made to ensure the information contained in this User
Manual is accurate, and is believed to be correct at time of printing.
IntroMedic reserves the right to change any content contained with this User

Manual without prior notice.

IntroMedic Co., Ltd. warrants the product against defects in material and
workmanship for a period of twelve (12) months from the date of sale, unless
different local regulations apply. IntroMedic Co., Ltd. will repair or replace
products that are ascertained by IntroMedic to have defects during the
warranty period. IntroMedic Co., Ltd. is not liable for the defects occurred by
misuse, careless handling, unauthorized modifications or erroneous use, or
any use that is non-compliant with instructions detailed within this User
Manual. This includes use of the product in non-appropriate locations or
conditions. Any other warranties are neither represented here nor recognized

by implication.

To validate the warranty, please complete product registration with the local

authorized IntroMedic distributor.
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Warranty

Exclusive warranty service

The warranty service provided hereby is applicable exclusively to the
purchaser of the product. IntroMedic will only warranty the product for
purposes and usage as defined in this User Manual. Any usage not heeding
the warnings, cautions and recommended usages as defined in this manual

will nullify the warranty.

Support

For warranty or repair service please contact the local authorized IntroMedic
distributor.

For customer service or support please contact your point of purchase or
IntroMedic Co., Ltd. Service agreements are only applicable to products of
IntroMedic Co., Ltd.

IntroMedic Customer Service
TEL: 82-2-801-9300
FAX: 82-2-801-9330
http://www.intromedic.com
E-mail: helpdesk@intromedic.com

Safety
Non-compliance with the user's manual, unauthorized modifications of the
product or replacement of parts, and/or opening of the product casing is

prohibited and may be hazardous.

Declaration on translation of labeling

Based on buyer's request, IntroMedic will provide the labeling, such as ID
label, Instruction for use and other promotional materials, which is translated
into the national language(s) of European countries. And it will be evaluated
by the local language expert, and will be confirmed by the native speaker of

the local language.
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Chapter 1 Safety Information

1. SAFETY INFORMATION

1.1 Warnings
MiroCam® has been manufactured to conform with the International

Standard for Medical Electrical Equipment: General Requirements for
Safety IEC 60601-1, together with the Collateral Standard for
Electromagnetic Compatibility Requirement and Tests IEC 60601-1-2.

MiroCam® has been manufactured to conform to the electric shock, fire
and mechanical hazard standards as defined in CAN/CSA C22.2
NO.601.1.

Based on request of the buyer, IntroMedic will provide the labeling, such
as ID labels, and the User Manual in the national language(s) of
European countries. Translated documents will be evaluated by a local
language expert, and will be confirmed by a native speaker of the

respective national language.

Safety Symbols: The User Manual incorporates various safety symbols
to ensure safe and correct use of the product and to prevent any personal
injury or property damage. These symbols are defined in the following
table:

WARNING

WARNING indicates a potential hazard that, if not avoided, could
result in serious personal injury or damage to the product.

21
CAUTION
A CAUTION indicates a potential hazard that, if not avoided, could
result in minor personal injury or damage to the product.

NOTE

A NOTE does not indicate potential hazards as in Caution or
= Warning, but contains important information regarding the
installation, operation or maintenance of the product.

eeIntro 1-3




Safety Information Chapter 1

1.2Symbols for Safety

This section describes a set of symbols that the IEC (International
Electrotechnical Commission) has established for medical electronic

equipment to classify connections and warnings of any potential hazards.

IEC 348: Notice for the user to pay special attention to the
following details

IEC 878-02-03: Indicates that this is classified into Type BF
equipment

EN 980: Denotes Date of Manufacture

EN 980: Denotes Address of Manufacture

IEC60601, ANNEX D: Denotes “ON” status of main power
switch

IEC60601, ANNEX D: Denotes “OFF” status of main power
switch

EN 980: Denotes serial number
IEC 417-5031: Denotes DC (Direct Current)

IEC 417-5032: Denotes AC (Alternating Current)

Denotes Ampere, the unit of current

<> il20 0Kk > -

Denotes Volt, the unit of Voltage

Hz Denote Hertz, the unit of Frequency

IEC 417-5021: Denotes potential equalization terminal

Single Use Only

L0 @ <

Use by date
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Safety Information

1.3Function Symbols

MiroView™ Function Symbols

1.31

MiroView™ software.

The following table describes symbols or icons used

in the

Description

(92}
<
3
o
=2

Description

Connect to the receiver
and open receiver control
screen.

L

Open the report screen to
create a patient capsule
endoscopy report.

Open the patient data

screen.

Open screen to export
(save externally) selected
image data for a specific

patient.

Open screen to review for a

specific patient

Select and save an image

being reviewed.

Place a landmark in an

image being reviewed.

Open the Color

Enhancement Window

Show images in full screen

Time Display

Show images in the Single

Screen

Show images in the Dual

Screen.

Show images in the Quad

Screen.

Show images in the Range
Mode.

Show images in the Map

View

Play all images.

n
=2

Play the selected images

only. View images via

Express Mode function.

OEEnfan

SGIB - Play the images
captured via Suspected Gl

Bleeding function.
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Symbol

Description

Description

Move to the previous

image.

Move to the previous

captured image.

.k -

Play images in reverse

order.

Stop playback of images.

Play

Play images in sequential

order.

Move to the next captured

image.

Move to the next image.

Open the Positioning
Window

Open the Comparison
Window

Expand/Shrink Capture

Box

Statistic Box

Show Circumference

Markers

Add a Circle on the image

Add a Line on the image

Delete selected Circle /

Line

Color Palette

Undo the action

Redo the action

: 2
EgoE i EEEEn:

Check selected captured

images

1-6

eSIntroMedic




Chapter 1

Safety Information

Description Description
Uncheck selected
Print
captured images
Review Save as PDF

Export Review

Open PACS function
(Registered User Only)

Export Captured Images
with EXMIF

Export Captured Images
as Image / Video /
MiroVideo

Export Segments as

Image / Video / MiroVideo

Export Case as Video /
MiroVideo

] | @
HBE O ODBEn:

Select the area as a

Segment

-
HE B BEE:

Deselect the area from

Segment

eSIntroMedic




Safety Information Chapter 1

1.3.2 MiroCam® Receiver Function Symbols

Symbol Description

Indicates status of signal from capsule
SIG G— Green : Signal is being received from capsule
Yellow : Signal is not being received from capsule

Initialization status of Receiver Unit
INI " Green : Receiver is initialized
Yellow : Receiver is not initialized

H]r Battery Status
Green : Fully charged
Yellow : Not charged
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Chapter 1 Safety Information

1.4 Notes for Safe Use

Follow the safety instructions included in this User Manual and clinical
precautions advised by the medical professional.

The manufacturer is not liable for harm or damage caused by improper,
unauthorized, unprofessional or inexpert use of the device and/or
product.

IntroMedic Co., Ltd. is NOT responsible for physical harm or
equipment problems caused by the user’s careless operation or
mismanagement of the device and/or product.

Users MUST have read and understood the User Manual. ONLY
trained and qualified medical professionals or authorized
representatives of IntroMedic Co., Ltd. may operate the system.

User Manual must ALWAYS be with the equipment. This is the USER’S
RESPONSIBILITY.

CAUTION: foreign substances including water, cleaning fluids,
disinfecting cleanser and such substances may harm the equipment,
and should not enter the equipment.

ONLY authorized personnel may perform repairs. Never attempt to
open covers, panels or casings.

DO NOT crease, bend, fold or twist the data cables. Take care to guard
them against mechanical stress (e.g. wheels or heels)!

The sensor pads, receiver, data cables, and capsules must not be
exposed to mechanical shock (e.g. by dropping). Any damage caused
that way will void the product warranty.

CAUTION: Damagel/injuries to the sensor pad or data cable may
cause a safety hazard. Damaged items MUST be repaired
IMMEDIATELY.

DO NOT handle fluids in the vicinity of the system.

When using a cart purchased elsewhere, ensure the brake or latch

guard is in use to prevent the wheels from rolling.

eeIntro 1-9



Safety Information Chapter 1

DO NOT USE in moist or damp places.

DO NOT operate the equipment with wet hands.

Avoid using the equipment in extreme temperatures or humid
environments.

DO NOT keep the equipment or carry out the procedure in places such
as areas exposed to direct sunlight, vicinity of heaters, vicinity of
chemical materials or gases, areas moist/damp or dusty, or poorly
ventilated areas.

DO NOT disassemble or open the equipment without permission. This
will invalidate the warranty.

DO NOT carry out the procedure in areas with high vibrations or in
environments where high electro-magnetic waves are generated.

DO NOT pull out the power cord by grabbing the cable. When
disconnecting the power cord, grasp the plug, and pull out. This
prevents short-circuits, disconnection, or cord damage.

CAUTION: Verify that the power voltage supplied from the power
receptacle matches with the voltage the system requires. Check
Voltage and Frequency on the AC/DC adaptor.

CAUTION: Turn off the power switch before connecting the sensor pad.
DO NOT discard sensor pads, cables and connectors with general
waste. Discard separately as industrial or medical waste.

CAUTION: Discard the battery according to the regulations of industrial
waste. DO NOT discard with general waste.

DO NOT carry out the procedure simultaneously with other procedures
using medical products or equipment.

DO NOT use for purposes other than medical treatment.

DO NOT connect the USB cable to the receiver while the receiver’s
data cable and sensor pads are still connected

DO NOT charge the receiver while the receiver's data cable and

sensor pads are still connected.
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Chapter 1 Safety Information

Connect USB cable to receiver only after mounting it on charger.
DO NOT install any other programs onto the workstation utilized for
review and diagnosis of patient image data (i.e computers with the
MiroView™ software).
The capsule is disposable and should not be reused.
The capsule and sensor pads are medical waste, and should be
disposed of according to local regulations or WEEE directive on waste
disposal.

B Only use the capsule, receiver, data cables and sensor pads in the
medical environment condition.

B All products connected with the MiroCam® Endoscope system must be
compliant with requirements of IEC60950-1 or UL certifications.

B Check the outer surface of the endoscope for rough surfaces, sharp
edges, or protrusions which may cause a safety hazard.

B Please don't try to cut the label.

eeIntro 1-11
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1.4.1 Environmental Conditions for Operation

B  Temperature :+0 C -+40C
B Relative humidity : 45% - 75%
B Atmospheric pressure : 700hPa to 1060hPa
AWARNING DO NOT operate the equipment in the vicinity of

[1] cAuTION

/\ WARNING

/\ WARNING

/\ WARNING

generators, power stations, X-ray devices, and
broadcasting stations where high levels of electro-magnetic
waves are generated. The electro-magnetic waves can
cause equipment malfunctions.

If the equipment has been brought in from a cold
environment (stock room, airfreight) into a warm room,
initial activation should take place after a few hours, to
allow for temperature adjustment and balance and
evaporation of condensed humidity.

DO NOT operate the equipment in the vicinity of heat
sources, strong electric or magnetic fields (close to a
transformer), or near instruments generating high-
frequency signals.

Do not use MiroCam® alongside or together with medical
devices or procedures involving electrical currents.

Do not use MiroCam® with h.f. surgical equipment. It may
result in burns at the site of the electrodes and possible
damage to the capsule and receiver.

Do not use the unit in close radius (within 1 m) of short
wave or microwave therapy equipment. It may produce
instability in the captured image.

This device is a Class B device according to EN60601-1-2
standards. This equipment can cause radio interference in
residential areas. In this case, the owner (or operator) can
be held responsible to take appropriate measures or take
proper measures for compensation.
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Chapter 1 Safety Information

1.4.2 Safety Precaution

Make sure the environment is without interference from

electromagnetic fields.

- Make sure the environment is without noise and
vibration.

- DO NOT carry out the procedure while using other
equipments, devices or products.

- The instruction for use of the sensor pads MUST be

observed.

- DO NOT use on patients with pacemakers or
defibrillators.

|I\ CAUTION DO NOT use the capsule if the package is unsealed.

[1] cAuTION

DO NOT reuse a used capsule.
To prevent unexpected accidents like fire or explosion, do not use any
product near or in the presence of inflammable or ignitable substances.

B DO NOT disassemble the equipment case nor open the cover. In case
service is required, please contact IntroMedic customer support or
local point of sale immediately.

B Only the accessories authorized and designed by IntroMedic Co., Ltd.
should be used with this equipment. Faults resulting from the usage of
unapproved or inappropriate accessories are not guaranteed against.

B This equipment may have an effect on other products or be effected by
other products.

B Follow your doctor’s instructions and abide by the guidelines in the
User Manual.

B DO NOT try to upload the data while the data cables are still
connected to the receiver.

B DO NOT charge the rechargeable battery in the receiver while the data

cable and sensor pads are still connected to the receiver.
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Safety Information Chapter 1

Stay away from high frequency radiation sites (such as high voltage,
radar, installation power plants, MRI, CT or electric blankets etc.)
during your capsule endoscope procedure. (It may result in serious
side effects requiring an emergency operation.)

In case of any symptoms of abdominal pain, vomiting, fever, heart
trouble, dizziness or seizure during or after the capsule endoscope
procedure, please notify your doctor.

Always check the connection between the receiver and the data cable.
Always check that the battery in the receiver is fully charged before
use.

DO NOT use the capsule if the package is unsealed.

After ingesting the capsule, always check whether the capsule has
been e xcreted.

Prior to undergoing the capsule endoscopy procedure, patients with
diabetes must be informed via a medical professional regarding
appropriate medication & dosage.

For more accurate data and better analysis, patients can have solid
food for lunch, but must have liquid food for dinner on the day prior to
the procedure. The patient must fast for 11 hours prior to ingesting the
capsule.

If recommended by the physician, the patient may take a laxative prior
to the procedure.

DO NOT smoke for at least 12 hours prior to the capsule endoscope
procedure.

DO NOT apply body lotion before the procedure.

DO NOT bite the capsule.

Avoid excessive physical activity during the capsule endoscope
procedure.

4 hours after ingesting the capsule, patients may have liquid food.

It is recommended to drink mineral water (non-colored liquid)
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Chapter 1 Safety Information

frequently, so that it may raise the possibility to take much better
quality of the image.

When undergoing the capsule endoscope procedure, DO NOT make
physical contact with another person undergoing the same procedure.
During operation of the receiver, DO NOT touch the receiver, or get the
receiver wet.

Only use the provided batteries, and never remove the battery from the
receiver during the procedure.

During upload of the data recorded in the receiver to the workstation,
avoid disconnecting the USB. This may damage the patient’s data.
Always confirm that the USB is connected by checking the Receiver
screen on the MiroView™ software.

Always check the AC Power range before use the workstation.

DO NOT touch AC Power code with wet hands.

DO NOT open the receiver bag or touch receiver outside of the
hospital.

This device is intended for patient over the age of 18.

AWARNING The Capsule takes a picture for 11 hours and gets naturally

excreted in about 24 hours under normal conditions. If the
capsule has not been excreted from the patient within 72
hours, patient should contact the physician. After
examining, the physician may need to perform a surgical
operation or treatment to remove the capsule.

&WARNING Before moving the system, always make sure to disconnect

the monitor from the main system, and then safely move
the main system and monitor separately. Connect the main
system and monitor only after the hardware is fully
installed, secure and stable.
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143

Cleaning and Maintenance

System and accessories
All products should be cleanly maintained. For cleaning, rub them
lightly with a soft cloth wet with warm water at least once a week.
Do not use organic solvents such as lacquer, thinner, ethylene and
oxide because they can damage the equipment. Be careful that
foreign substances do not enter the main system when cleaning.
ALWAYS operate the equipment under sanitary environmental

conditions. DO NOT use heat or gas for disinfection of the capsule.
Service Document

If required, or upon request, the local IntroMedic Distributor (authorized
IntroMedic Representative) may provide block diagrams, lists of spare
parts, descriptions, adjustment instructions or other related information
which may help qualified technical personnel in repairing specified
parts of the equipment which have been defined repairable by
IntroMedic Co., Ltd. .

Moving the Equipment
CAUTION when moving equipment.
WARNING: Excessive impact/shock causes internal damage.
If wiring is connected/disconnected when moving, check the exact
wiring status after moving.
If damage to the equipment is discovered after moving, immediately

contact IntroMedic or local Distributor.
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Chapter 2 Overview & Intended Usage

2. SYSTEM OVERVIEW

MiroCam® is an orally ingested capsule endoscope designed to capture
and wirelessly transmit images of the lining of the small intestine.
Captured images are viewed via the MiroView™ software for diagnosis of

diseases related to the small intestine.

The MiroCam® capsule endoscope system consists of the MiroCam®

capsule, MiroCam® receiver, MiroView™ software, and accessories.

2.1Intended Purpose

MiroCam® is intended for visualization of the small bowel mucosa as an
adjunctive tool in the detection of abnormalities of the small bowel. The
device captures images of the small bowel with a wireless camera
contained in a capsule. This device includes an ingestible capsule
(containing a light source, camera, transmitter, and battery), an electrode
array, a receiving/recording unit, a data storage device, computer

software to process the images (MiroView™), and accessories.
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Overview & Intended Usage Chapter 2

2.1.1 Contraindications

B Not intended for patients with known or suspected gastrointestinal

tract obstructions, perforations, strictures or fistular.

B Not intended for patients who have difficulty ingesting food or pills
(dysphagia).

B Notintended for patients who have difficulty communicating.

B Not intended for patients with indigestion, or slow gastric emptying.

B Not intended for patients who may be affected by electromagnetic
radiation, such as pregnant women, infants, and patients with heart
disease or epilepsy.

B Notintended for patients with diverticulosis in the Small Bowel.

B Not intended for patients who are recommended against having the

procedure by a Physician.
B Notintended for patients with pacemakers and/or defibrillators.
B This device is intended for patient over the age of 18.

2.2 Observable Diseases

2.21 Obscure gastrointestinal bleeding (OGIB)

B Angioectasia
B Meckel diverticulum

B NSAIDs

2.2.2 Crohn’s Disease
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2.2.6

2.2.7

2.2.8

Small Bowel Tumors

Polyps

Peutz-Jeghers Syndrome

Familial adenomatous polyposis
Lymphoma

Carcinoid

Gastro-Intestinal Stromal Tumor (GIST)
Lipoma

Hemangioma
Inflammation

Intestinal Tuberculosis

Typhoid Fever

Angeitis

Amyloidosis

Eosinophilic enteritis
Celiac Disease
Behcet’s Disease
Cowden Disease

Cronkhite-Canada Syndrom
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2.3Product Lifetime

2.3.1 Maximum Storage Time of MiroCam® Capsule

m  MC1000-C : 1 Year
m  MC1000-F : 1 Year
m  MC1000-G: 1 Year

2.3.2 MiroCam® Receiver, MR1000

B MiroCam® Receiver Battery : 4.62 Year

e%Intro
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2.4Product Specification

2.41

m  Component

MiroCam® Capsule

Component Model Name Quantity
Capsule MC1000 1 Piece (Optional)
MC1000-F
MC1000-G
Sensor Pads MC1000-S 10 Piece
B Specification
Item Specification
Capsule Unit | Size 11 X 24 mm
(MC1000, Weight 3.4 + 0.05g
MC1000-F, Frame Rate 3 frame/sec
MC1000-C) | £ie1d of View 150 degrees
Battery Life 12 hours
Pixels 102,400
Lighting 6 LEDs
Communication Human Body
Method Communication
eSIntro 2-7
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MiroCam® Receiver

B Component

Component Model Name Quantity
Receiver Unit MR1100 1 piece
Battery Pack MR1100-B 2 piece
Data Cable MR1000-D 1 piece
Receiver Bag MR1000-G 1 piece
System Carrying Case MR1000-A 1 piece
Battery Charger MR1000-C 1 piece
Adaptor MR1000-T 1 piece
Power Code MR1000-P 1 piece
Measuring Tape MR1000-M 1 piece
USB Cable MR1000-U 1 piece

B Specification
Item Specification
Receiver Unit Battery Life 12 Hours
(MR1100) Size 83.5 X 138 X 28 mm
Weight 350g(including Battery)
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ltem Specification

Battery Pack Type Lithium-lon storage cell
(MR1100-B) Capacity 10400mA

Voltage 3.6V

Recharging Time | Approx. 4 hours

Size 73.8 X 84.3 X 21.4mm
Data Cable Channel 9
(MR1000-D) Length 90cm
Receiver Bag Size 100 X 190 X 55mm
(MR1000-G)
System Carrying | Size 480 X 350 X 100mm

Case(MR1000-A)

Battery Charger Power Source Adaptor

(MR1000-C) Size 135 X 75 X 105mm
Weight 285¢g

Adaptor Weight 2319

(MR1000-T) Power Rating AC100~240V/ 50~60Hz

Power Code Length 1.5m

(MR1000-P)

Measuring Tape Length 1.5m

(MR1000-M)
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MiroCam® Software

Component
Component Model Name Version
MiroView™ Workstation MiroView™ 2.5
MiroView™ RTV MiroView™ RTV 1.0
Wireless MiroView™ RTV | Wireless MiroView™ RTV | 1.0

eIntro




Performing Capsule Endoscopy




Chapter 3

Performing Capsule Endoscopy

e%Intro



Performing Capsule Endoscopy Chapter 3

3. PERFORMING CAPSULE ENDOSCOPY

3.1 General Comments

B This chapter describes how to operate and control MiroCam®

capsule endoscope system.

B Installation and initial operation must be done by an Authorized

IntroMedic Service Technician.

3.2Safety Warnings

/\ WARNING

[1] cAuTION

[1] cAuTiON

[1] cauTioN
[1] cAuTION

[1] cAuTION

@  NOTE

Before turning on the system, check the environment
condition for MiroCam® capsule endoscope system.

In case the system has been brought from cold
environment (stock room or airfreight) into a warm room,
you should first switch on it after some hours for
temperature balance and removing of condensation
humidity (Risk of leakage current).

For the electrical safety, make sure that peripheral
equipments (external PC, Monitor, printer etc) should be
connected to wall socket of independent power supply with
a perfect ground. Particularly make sure whether or not
those peripheral equipments should be authorized for
medical usage.

DO NOT touch the dome of the capsule.

if SIG indicator of the Receiver turns yellow after ingesting
the capsule, immediately contact the physician.

If SIG indictor of the Receiver does not turn green when the
patient holds the capsule by the gold bands, immediately
stop the procedure.

If images of the small bowel are not captured during the
procedure, ensure the capsule has been excreted by the
patient and perform procedure again.
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Chapter 3 Performing Capsule Endoscopy

3.3 Examination Preparation

The following steps (3.3.1 to 3.3.4) explain the process to initialize the
receiver and register patient data for the capsule endoscopy procedure.

For more information see section 4.2.
3.3.1 Start System

B Turn on power of MiroCam® workstation.

B Click ®” icon to start the MiroView™ 2.0 Operator.

B [nsert the ID and password and click icon.

D .ﬁ.d minisirator

Passward

Remambar yaur ID an his comgpuler

&WARNING Before starting the system, check the power rating for the
workstation.

3.3.2 Initialize the Receiver

B Connect the smaller connector of USB Cable to Receiver unit.
B Connect normal connector of USB cable to workstation.

B Turn on the power of the Receiver unit.

m  Click BE=2H icon in MiroView™ 2.0 Operator.

m  Click icon in MiroView™ 2.0 Operator.

B After completing the required fields, click the m button to
save the patient information onto the Receiver.

3-4 eSIntroMedic
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@ Note Before execute MiroView™ 2.0 Operator, connect USB

cable to MiroCam® Receiver unit.

AWARNING If MiroCam® receiver unit is initialized, any patient data
stored on the device will be deleted permanently.

3.3.3 Receiver Preparation

Connect battery to the Receiver unit.

- Insert pins on back side of the Receiver unit in the slots on the
battery.

- Press battery to receiver until clasp locks battery in place.

Turn on power switch of receiver unit.

Check battery indicator (BAT) of upper side of receiver unit. If

battery is fully charged, light will be green. If light is not green,

charge the battery.

B Check initialization indicator (INI) of upper side of receiver unit.

Prior to beginning a procedure, this light must be green.
B Connect data cable to receiver unit.

Indicator Description

Indicates status of signal from capsule
SIG 6— Green : Signal is being received from capsule
Yellow : Signal is not being received from capsule
Initialization status of Receiver Unit
INI 55 Green : Receiver is initialized
Yellow : Receiver is not initialized
. Battery Status
r“' Green : Fully charged
Yellow : Not charged

BAT

A WARNING DO NOT do begin procedure when receiver unit's battery
indicator is not green. This indicates battery is not fully
charge or out of order, and patient data may be lost.
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Chapter 3 Performing Capsule Endoscopy

3.4Patient Preparation

Provide the patient with the following instructions to prepare for the
capsule endoscope procedure.

3.4.1 Patient Preparation
B One day prior to the capsule endoscope procedure

- Lunch: Patient can have a normal mean around noon, followed
by a liquid diet as instructed by the physician.

- The patient should fast for at least 12 hours prior to the
procedure. Patient may only drink water (no food or other
beverages such as milk or coffee).

- The patient should not take any medications two hours before
ingesting the capsule endoscope.

- Male patients may need to shave area, as advised by
physician or nurse.

- Patient should stop taking iron supplements 1 week before the
capsule endoscope procedure, and should not ingest any
medicine at least 2 hours prior to the procedure.

- Diabetic patients need to follow any changes to insulin dosage
as prescribed by the physician.

- Physician is recommended to prescribe patient a laxative such
as PEG or Sodium Phosphate. Patient should ingest laxative
12 hours prior to procedure.

- Physician is recommended to prescribe patient an anti-foaming
agent (such as simethicone), to reduce bubbles in the Gl tract.
This should be ingested after the laxative.

- The patient should abstain from smoking 12 hours before the
procedure.

- On the day of the capsule endoscope test, the patient should
wear comfortable and loose cloths. One-piece clothing should
not be worn.

- Prior to the procedure, do not apply any lotions or perfumes.

B On the day of capsule endoscope procedure

- After arriving in a hospital at the appointed time, the patient
should submit an examination permission form and check in.

B After ingesting capsule endoscope
- The patient should refrain from taking any food or drink two

hours after ingesting the MiroCam® capsule endoscope. Water
is permitted after two hours.
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- The patient can start with light food after 4 hours. When the
examination is complete, the patient can start having normal
meals.

- In case of any abdominal pain, nausea or vomiting after
ingesting the MiroCam® capsule, the patient should contact
physician or nurse immediately.

3.5Sensor Placement & Capsule Ingestion

Following is the detailed procedure required to correctly administer the
capsule endoscope procedure.
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3.5.1 Connecting Sensor Pads

After attaching sensor pads to the data cables, attach the sensor pad
correctly to each area as shown below.

Xiphoid process Line

Pelvic Line
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Xiphoid

process Line

Pelvic

O

Attach sensor pads according to the number on the data cable.

Line

Locate the center between the umbilical and the xiphoid process.
From this center point, attach the sensor to the distal point on
the right flank of the patient’s body.

Place the sensor pad on the xiphoid process line, directly below
the right clavicle.

Place the sensor pad on the xiphoid process line, directly below
the left clavicle.

Locate the center between the umbilical and the xiphoid process.
From this center point, attach the sensor to the distal point on
the left flank of the patient’s body.

Place the sensor pad on the right pelvic line, 2 cm behind
sensor #1.

Place the sensor on the right inguinal line, 2 cm to the outside of
sensor #2.

Place the sensor on the right inguinal line, 2 cm to the outside of
sensor #3.

eeIntro
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- Place the sensor pad on the right pelvic line, 2 cm behind
sensor #4.
- Place the sensor directly below the right clavicle.

|I| CAUTION The numbering of the data cables and sensor pad must
match the specified area. Please follow the numbering
sequence appropriately.

m CAUTION To prevent entanglement of the data cables during
procedure, organize cables and place appropriately in cable
bag.

AWARNING Correct image signal may not be obtained if a sensor pad is
not in direct, immediate contact with the skin. Ensure the
sensor pads are in direct contact with the skin. Shaving
may be required for male patients.

The pictures below show the sensor pads attached in the correct locations.
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3.5.3 Removing Capsule from Packaging

While holding the MiroCam® upside down, peel off the sterilized
packaging cover.

3.54 Removing the Case

Turn the package over, the MiroCam® case will slip out of the
packaging. While holding the MiroCam® case, open the lid.

S

3.5.5 Removing the Capsule

Grip capsule with right hand, and remove from cast. Do not touch the
dome of the capsule.
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B Make sure that the capsule packaging is not damaged in any way.
When removed capsule from case, the capsule should be flashing.

m CAUTION Do not use a capsule endoscope when the packaging or
the capsule is damaged.

B Check if the front of the capsule is flashing when it is removed
from the case

B After washing hands, patients should grip the gold section of the
capsule between the thumb and the forefinger of the both hands.

@ NOTE After turning the receiver power on, if a signal is not received
by the receiver within 50 seconds (i.e. the SIG indicator does
not turn green), the SIG indicator will flash orange and the
receiver will make a ‘beep’ ‘beep’ warning sound. This will
occur until a signal is received or the power is turned off.

In this case, you must begin the procedure immediately or
turn the receiver off until ready to begin the procedure.

eSIntroMedic
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3.5.6

Checking Operation of the Receiver and Signal Reception

After the patient holds the capsule as detailed above, the signal
indicator on the receiver is green and signal indication melody is
generated.. If signal indicator is yellow, there is no signal being

received from the capsule.

Switch on the receiver.

Check if the battery indicator (BAT) at the top of the receiver shows
that the battery is fully charged. The battery indicator on the
receiver should be green.

Check if the initialize indicator (INI) at the top of the receiver shows
that initialization is complete. The INI indicator on the receiver
should be green.

Connect the data cable to the MiroCam® receiver.

After patient grasps capsule by opposing gold bands (as detailed
in picture above, check the SIG indicator on the receiver is green

and signal indication melody is generate.

m CAUTION [f the battery indicator on the receiver shows that the

battery is not fully charged, do not start the endoscopy
procedure. The battery may be depleted during the
procedure and images may not be saved properly.

II‘ CAUTION Please be noticed to confirm the shape and the direction of

the connector when you connect the data cable to
MiroCam® Receiver, since it may cause cable damage
problem.
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3.5.7 Ingesting the Capsule

After checking if the signal indicator on the receiver is green, ingest
the capsule with water.

|I| CAUTION Do NOT bite the capsule while ingesting.
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3.5.8 Checking and Wearing the Receiver

B After ingesting the capsule, make sure that the SIG indicator is
green.
Place the receiver in the bag.
Organize the contents of the bag so that the cables are not
entangled.
Adjust cables, and place excess in cable bag.

Adjust the bag strap as needed.

i

B Capsule endoscopy procedure will be complete after 11 hours.

|I| CAUTION Patient should not touch receiver during the procedure. This
may lead to loss of image data.

lII CAUTION During the procedure the SIG indicator should be green.
In this case, check data cable to ensure it is securely
inserted and check the sensor pads to ensure these are
fixed to the body.
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3.6Uploading Images

Once the capsule endoscopy procedure is complete, upload image data
from the receiver to the workstation and start diagnosis of the data using

MiroView™ 2.0 Software.
3.6.1 Transferring and Checking image data

B Switch on the workstation.
B Click the ®“ icon on the desktop to launch MiroView™ 2.0
Operator.

B When the login window appears, enter the user ID and password,

Login

and then click the button.

Connect the smaller end of the USB cable to the receiver.
Connect the other end of the USB cable to the workstation.
m  Click the button in MiroView™ 2.0 Operator.
B When the image data in the MiroCam® receiver is successfully

uploaded, execute MiroView™ 2.0 client to review and report.

AWARNING For more information on using MiroView™, please refer to
Chapter 4, Using MiroView™ 2.0.
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3.7 Receiver Management — Post Procedure

3.71

Cleaning

Remove data cable from receiver unit.

Capsule and sensor pads should not be reused.

To clean the MiroCam® Receiver unit and Workstation, dampen a
soft cloth with warm water or with a commercial, nonabrasive
cleaner (or a mild soap or detergent solution) and wipe the exterior
surface lightly. Do not allow any liquids to come in contact with the
power connector, cable connector or switches. Do not allow any
liquids to penetrate connectors or openings in the system cover.
Cleaning of the system and accessories should be conducted at
least once a week.

II\ CAUTION Do notimmerse the MiroCam® capsule endoscope system

3.7.2

or its accessories in liquid or clean with caustic or abrasive
cleaners. Do not spray or pour any liquid on the system or
its accessories. Do not use the organic solvents such as a
lacquer, thinner, ethylene and oxide because they can
damage the equipment. When cleaning the data cables, do
not use the cleaning tools such as brush and sandpaper.

Charging Battery

Battery must be recharged after every procedure.

Battery can be individually recharged or with receiver unit.

Battery must be recharged in battery charger.

If two batteries are inserted in charger, the batteries will
automatically consecutively charge (not simultaneous).
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B Connect adapter DC cable to battery charger.
B Connect AC power code to adaptor.
B Connect AC power code to AC consent or multi-tap.
B Battery charger indicator lights:
B Battery is charging when green light is blinking
W Battery is fully charged when light is solid blue
B Battery is not-charging if light is yellow
B Note: second battery in charger will automatically begin
charging once first battery is fully charged.
3-18 eSIntro
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Waiting
Charging
Charging
Charged
.
/\ WARNING
/A WARNING
/\ WARNING

If the indicator on the battery charger is blinking yellow
there is a bad connection. Please disconnect the battery
from the battery charger and try again.

Only use batteries provided by IntroMedic. Usage of
inappropriate batteries can cause serious damage to the
receiver.

Recharge the MiroCam® receiver batteries with the
adaptor and the battery charger only from IntroMedic.
Improper adaptors and battery chargers cause serious
damage.
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Chapter 3

Performing Capsule Endoscopy

A\ WARNING

A\ WARNING

A\ WARNING
A\ WARNING
/A\ WARNING

Try not to contact the metallic terminal board of batteries
with conductive objects or human body. It can cause an
electric shock or damage and/or breakage of the
batteries.

Do not use the batteries with visible surface damage on.
Usage of damaged batteries can result in leakage of
contents of the batteries.

To avoid the risk of explosion, keep batteries away from
fire.

Treat the batteries carefully from serious impact or shock.
This can cause serious damage to the batteries.

Do not expose the batteries to liquids. This can cause
serious damage.

3-20
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4. USING MIROVIEW™

MiroView™ is a computer software program that aids in diagnosis of disease
of the small bowel via displaying images obtained from the MiroCam®
capsule.

MiroView™ version 2.5 is an update to the MiroView™ version 1.0. The
updated functionalities and user interface further enhance the efficiency and
effectiveness of the MiroCam® capsule endoscopy procedure.

Following is a list of new & updated features:

- User Interface
% MiroView™ enables adjustable resolution, to appropriately fit to the
screen size.

¥ MiroView™ has been designed with a dark background to reduce eye
strain.

< MiroView™ provides intuitive and unified icons so that the user can
adapt quickly.

- Reporting Tool

- Express View

- Range View

- Network Support

- Account Management

- Multi-Review / Report Generation Support
- Multi-Receiver Management Support

The workstation where the MiroView™ is installed properly has icons for four
applications on the Desktop folder: MiroView™ Client, MiroView™ Operator,
MiroView™ Server, and MiroView™ Viewer. However this manual will not
explain how to use the MiroView™ Viewer. For additional information for
MiroView™ Viewer, please refer to the MiroView™ Viewer Instruction Manual.
To get the installation procedure for MiroView™, refer to the MiroCam®
Service Manual.
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MiroView™
Client
This  program is

used for reviewing the
images from the
MiroCam®  capsule
and generating a
patient report. The
MiroView™ Server
should be started
prior to starting the
MiroView™ Client.

Functions:

- List Mode
- Review Mode
- Report Mode
- Export Mode
- Image Atlas
- SGIB
(Suspected
Gl Bleeding)
- Positioning Window
- Network connectivity
- Multi-Review
- Express View
- Range View
- Map View
- Gl Dictionary
- Finding / Diagnosis
Information

ﬂ-(‘p.?“
&

MiroView™

Operator

This  program is
used for managing
the receivers
(initialize, upload etc.)
and managing user

accounts. The
MiroView™ Server
should be started
prior to starting

MiroView™ Operator.

Functions:

- Input Patient
Information

- Receiver
Initialization

- Upload Data from
Receiver

- Data Backup

- Account
Management

- Network connectivity

(.ﬁ"’:

MiroView™

Server

The server stores

the patient data files.
Start the MiroView™
Server prior to
starting  MiroView™
2.0 or MioView™
Operator.

Functions:

- DB, Mass storage
- Network connectivity

MiroView™

Viewer

The MiroView™
Viewer is used for
reviewing the images
exported from the
MiroView™ Software;
EXMIF  or JPEG
images.

Functions:

- Study Information

- Image Information

- Show Findings /
Diagnosis

4-4
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4.1 MiroView™ H/W Specifications

411

41.2

MiroView™ Server

Minimum Hardware Requirements

OS: Windows Vista Business
CPU: > Core 2 Duo E6300
Memory: > DDR Il 4GByte

Video Card: Windows Compatible
HDD: SATA 500GB

ODD: DVD+-RW

Monitor Resolution: 1024x768

Recommended Hardware Requirements

OS: Windows Vista Business
CPU: > Core 2 Duo E6300
Memory: > DDR |l 4GByte

Video Card: Windows Compatible
HDD: SATAIl RAID 1TB

ODD: DVD+-RW

Monitor Resolution: 1680x1050

MiroView™ Client

Minimum Hardware Requirements

0OS: Windows XP, Vista or Windows7
CPU: Pentium4 2 Ghz

Memory: 1GB

Video Card: Geforce 7600GT 128MB
HDD: SATA 160GB

ODD: DVD+-RW

Monitor Resolution: 1024x768
Sound Card / Mike / Speaker

Recommended Hardware Requirements

0OS: Windows XP, Vista or Windows7
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CPU: > Core 2 Duo E6300

Memory: > DDR |l 2GByte

Video Card: > Geforce 7600GT 128MB
HDD: SATA Il 500 GB

ODD: DVD+-RW

Monitor Resolution: 1680x1050

Sound Card / Mike / Speaker

4.1.3 MiroView™ Operator

Minimum Hardware Requirements

OS: Windows XP, Vista or Windows7
CPU: Pentium4 2 Ghz

Memory: 1GB

Video Card: Windows Compatible
HDD: SATA 160GB

ODD: DVD+-RW

Monitor Resolution: 1024x768

Recommended Hardware Requirements

OS: Windows XP, Vista or Windows7
CPU: > Core 2 Duo E6300

Memory: 1GB

Video Card: Windows Compatible
HDD: SATA 160GB

ODD: DVD+-RW

Monitor Resolution: 1024x768

41.4 MiroView™ Viewer

Hardware Requirements

0OS: Windows XP, Vista or Windows7
CPU: Pentium4 2Ghz

Memory: 1GB

Video Card: Windows Compatible
HDD: SATA 160GB

ODD: DVD+-RW

Monitor Resolution: 1024x768
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|I| CAUTION MiroView™ cannot be viewed on a monitor with a resolution
under 1024x768.

@ NOTE The GUI s best viewed on a wide monitor of 19” or larger.
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4.2 Overview — MiroView™ Server

The MiroView™ Server software is intended to be used as a system
administrative managing tool. The MiroView™ Server manages file
systems and database systems.

When powering up the workstation, MiroView™ Server will start
automatically. If the following window appears, please set up the
configuration for the first run.

IP Address |‘- 0.04

Port |2000 ; Q)
Administrator Password Il
Password | : = ®
Canfirm | ‘ Il‘ ®
Local File Path
FiData | |:J
Language
Language |Eng\ish v‘
Hospital Information
Country | AFGHANISTAN -
Hospital Name |3 @

B Set the port number for the Network. If unknown, please leave this
field as ‘2000. This field should be managed by your Network
Administrator in your hospital.

B Set the password for ‘Administrator’ account. Additional accounts
can be made via Account Manager function, after logging on the
MiroView™ Operator as ‘Administrator’.

B Confirm the password.

B Type the Hospital Name.

4-8
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Pert ‘2000

Adminisirator Password

Password ‘

Caonfirm ‘

Local File Path

F\Data

Language

Languags ‘ English

Haospital Information

Counfry | AFGHANISTAN

Address

a

l
Hospital Name ‘ a

:

|

Telephone

B Type the Address that should appear on the Capsule Endoscope
Report.

B Type the Telephone Number that should appear on the Capsule
Endoscope Report.

@ MiroView Server @

Server Help

Connection List

Time r Status |

2010.01.08 15:54:55 127,0.0.1 Cannection

e2IntroMedic

B After setting up the Configuration Windows, MiroView™ Server
window above will appear. Click the . icon to hide the window.
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4.30verview - MiroView™ Operator

MiroView™ Operator software is intended to be used for administrative
purposes, including account and receiver management.

4.3.1 Start MiroView™ Operator

B Double click the (“f: icon to run the MiroView™ Operator.

When executed for the first time, the following window will appear.
[ Config &J‘

Nelwork

P Addrass| [127.0.01

Port |2000

Local File Path

|D:\Data

Language

|Korean[Kore aj

Cancel

| input “127.0.0.1” for the IP Address and “2000” for the Port.
B Direct the “Local File Path” to the caching folder and choose the

Finish

preferred Language settings and press button to access

MiroView™ Operator.
B After MiroView™ Operator has launched, the Log-in window will
appear.

o :m_im[nisunlm
Passward: |

Rarmgmaar yaur ID an s compuler

4-10 eSIntroMedic



Using MiroView™ Chapter 4

B nput ‘Administrator’ for ID and password. Then press the
button.

m CAUTION D and password are encrypted. Do not forget the ID and
password.

|I\ CAUTION Before MiroView™ Operator has launched, you must create
the password for the administrator account. When running
the MiroView™ Server for first time, the user must create
the password for the administrator account.

@ NOTE You can create new and edit existing accounts by using the
Account Management tool on MiroView™ Operator.
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The following subsections describe the main interfaces and functions
of the MiroView™ Operator.

4.3.2 List Mode

E [mjly BF Thursday, Oclober 02, 2008 Miae 820101-1526112 Adrinistrator [ 58} &X

@ List Mode Opens List Mode

@ Receiver Mode Opens Receiver Mode

® Print Report Print out the selected Report

@ Recycle Bin Open Recycle Bin Window

® Export Export the selected Report

® Search Search Cases and/or Reviews by keyword

@ Show all Refresh and Show all the Cases and Review on
the List
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4.3.3 Receiver Mode

Screen enables administration and status display for u toéour

receivers.

Receiver &

Upload

Input Patient’s
Information
Initialization

Receiver Port

©@ ® ® OO

Detail View

Recaiver SN: 2

| Data(uploaded)

Upload images in the receiver to the server
Input Patient's Information to the selected
receiver

Delete all data from the receiver and/or
prepare the receiver for the next patient.
Shows the status of the connected receiver for
each of the four ports

Shows the patient’s information for the
selected receiver

eIntro
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4.3.4 Receiver Initialization

Click the button to initialize the selected receiver.

Connected to server @@

4 =

Receiver SN : 27102

~~

) Formatting...

~—

00:00:00
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4.3.5 Inputting Patient Information

Click the button to enter the patient information. After

completing the required fields, click the button to save the
patient information onto the Receiver. The fields in the patient
information are editable and additional fields can be added. This can
be accessed via Tools > Preferences > Receiver > Set > Add /
Modify.

Patient information

‘ ‘ Check names

=i || \

*Gender ‘ Unknown

*Birth date ‘ 5192009

*Procedure date ‘ 5/19i2009

=Capsule type  |sB

*Capsule Sn ‘

*Doctor

|
| [ checknames |

Height ‘U-UU ‘ |inch

Weight ‘0 oo ‘ |kg

Waist ‘U-UU ‘ Iinch

Shape type | Slight

Insurance ‘ ‘

GroupNo | \

Registered by ‘ ‘

Recording time - 00:00:00

* indicates required fields.
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4.3.6 Data Upload
After the capsule endoscopy procedure, upload the data from the
Receiver to the MiroCam® system via MiroView™ Operator.  Click

the button to upload the data from the Receiver.

After the image data in the MiroCam® Receiver has been
successfully uploaded, enter the List Mode and check if the new Case
has been created.

- Double click the ®” icon to run MiroView™ Client.

- Select the newly uploaded Case and enter the Review Mode.
- Play the case to check the uploaded image data.

|I| CAUTION [f you fail to upload the data from the Receiver,
disconnect and reconnect the USB cable from the
workstation, then turnoff the MiroCam® Receiver
and turn it back on. Try uploading again. If the
problem persists, please contact IntroMedic.

@ NOTE ![f the user uploads a patient data which has been
uploaded before, an error message ‘Data has been
previously uploaded. Would you like to upload
again?’ will appear.

@ NOTE Upload progress will be displayed. The user can
stop the process while uploading by clicking the
button.
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4.3.7 User Account Management
MiroView™ Operator enables management of multiple users &
Groups. Users can be organized into Groups to readily control
access. The following screen can be accessed by Tools = Account

Manager.

Administrator Administrator Administrator

Kim Kim : User

F-pCB

Create

Change Password
- To Change the Password, Click Change Password
Change P

Dislog =
=T
D Name Level Group.

Modify

Change Password

-To Change fhe Password, Click Change Passward

eSIntroMedic
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Add an account. Click button to show the window as
displayed below.

D |

Password |

Type |Use(

Name | |
i

Group |Defau\t

ID: User ID
Password: Password
Name: User Name
Type: User type.
- Super User: can access all the reviews in the System
- User: can access all the reviews in the Group of the User’s
- Operator: can log in via MiroView™ Operator S/W only.
% Administrator account can log in via both MiroView™ Client and
MiroView™ QOperator.

Group: Set of users in the same Clinic or Laboratory.

4.4 Overview - MiroView™ Client

4.41 Start MiroView™ Client
B Double Click the ®button to run MiroView™ Client.

ID: [Doctor |

Password ‘**** ‘

| Remember your ID on this computer

Lagin

Login

B Enter the User ID and password and click the button.
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4.4.2

©O0e O

PR ©0POERAPO®OOO

List Mode

List

List Mode
Review Mode
Report Mode
Export Mode
Print Report
Add a Review
Delete Case
Delete Review
Recycle Bin
Search

Show all

Selection Bar
Detail View

8201011526112/ Miae / 27 / Male

——— o —————

Open List Mode

Open Receiver Mode

Open Report Mode

Open Export Mode

Print selected Report

Add a Review for the Selected Case

Delete selected Case

Delete selected Review

Open Recycle Bin

Search Cases and/or Reviews by key word
Refresh and Show all the Cases/Reviews on the
List

Arectangular area to show selected item

Show Detail Information for selected Case or
Review

eSIntroMedic
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4.4.3 Review Mode

Select a case to review on the List Mode and click the . icon to
enter the Review Mode.

B Capture Box Mode
DO®

-/

@
r
@
® EOROLLEBYWWL WL © VW WX ® @
@ List Mode Open List Mode
@ Review Mode Open Review Mode
® Report Mode Open Report Mode
@ Export Mode Open Export Mode
® Positioning Window Current position of the capsule in 2D
® Single View Change to Single View
@ Dual View Change to Dual View
Tri View Change to Quad View
O] Range View Change to Range View
Normal View Shows all images taken by the
Capsule
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Express View

SGIB

Previous Image
Previous Capture
Play Backward
Pause / Resume
Play Forward
Next Capture
Next Image
Capture
Landmark

Image Enhancement

Time Display

Zoom View
Comparison Window

Thumbnail Extension

Capture Box

Actively removes images based upon
similarity; effectively reducing the
number of images for review. This
mode is recommended to review the
patient file.

Shows images that have high
possibility of bleeding and / or blood.
This mode may assist in finding areas
of suspected bleeding; however, it is
NOT 100% reliable, and should only
be used as an adjunctive tool to assist
in reviewing the images.

Go to Previous Image

Go to Previous Capture

Play Backward

Pause / Resume

Play Forward

Go to the Next Capture

Go to the Next Image

Image capture button.

Set landmarks for transition points in
the Gl tract.

Alter images characteristics (ie. color,
saturation etc.) to assist in identifying
abnormalities.

Displays the time duration of the
capsule from procedure start.

Fit image to full screen

Displays the image selected from the
Image Atlas.

Extends the Capture Box to display all
captured images.

Toggle the Capture Box to Thumbnail
and Finding Summary Box

eIntro
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Finding Summary Box

Finding Summary Box

PER—— -

Toggle the Capture Box to Thumbnail
and Finding Summary Box Initially, a
captured image will be classified as a
generic ‘capture’. A user may classify
a finding through the reporting tool
Auto-Finding Checker, which will then
appear in the appropriate category in
the Finding Summary Box (if it is one
of the major categories).

4-22
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B Mode Control

- Zoom View

Click the ﬂ icon to change to Zoom View mode

@ NOTE Play Slide Control is available on the Zoom View
mode to set playing direction and speed.

@ NOTE Move the cursor away from the bottom of the
screen and the Play Control will appear.
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- Viewing Modes

Select one of the - icons for preferred Viewing

Mode.

Quad View Range View

@ NOTE Range View has been designed to assist in readily
finding transition points in the Gl tract. The display
will show 9 images before and 9 images after the
current position. The 9 images are defaulted to 10
minutes apart, resulting in an overview of 90
minutes prior to, and 90 minutes after the current
position. The number of images displayed is set at
9, and is not configurable. The 90 minute duration
is configurable and can be adjusted by clicking and
dragging the mouse icon on the time boundary.
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Map View

% Map View

This view has been designed to
assist in findings by showing all
the images on the same page
like a wall paper.

You can move the cursor on the
designated image to see the
original image in detail.

Express Mode

eIntro

4-25



Chapter 4 Using MiroView™

B Activated Windows

- Positioning Window

Displays the location of where the

capsule took the current image.

- Comparison Window
Displays the image selected from the

Image Atlas.

- Image Enhancement Window
Alter images characteristics (ie. color,
saturation etc.) to assist in identifying

abnormalities.

oK Default
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444 Report Mode

Select the desired review for the Case from the List Mode and click the

. icon to move to the Report Mode.

B Report Mode

List Mode
Review Mode
Report Mode
Export Mode
Scale

Drawing Tools

Q © 00O

Image
Enhancement

Open List Mode

Open Review Mode

Open Report Mode

Open Export Mode

Opens graduated scale for display on the
image

Enables users to include annotations for the
image.

Alter images characteristics (ie. color,
saturation etc.) to assist in identifying
abnormalities.

eSIntroMedic
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Gl Dictionary Provides the frequently-used-words to search.

@ Text Comments Write comments for the Capture on the main
display and the report.
(Image Comments, Reason for Referral,
Procedure info & findings, Summary &
Recommendation)

Audio Comment Record voice commenst
(The user can record min 3 sec ~ max 300
sec for each Capture)

@  Input Word Input the selected word into the text editor.
@ Add Word Add the typed word into the Dictionary.
@ Delete Word Delete selected word from the Dictionary.

@ NOTE Additional tabs in the report can be created or
modified via Tools -> Preferences -> Report
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445

) SYICASXORS

@O®Q

Export Mode

List Mode
Review Mode
Report Mode
Export Mode
Check
Captured
Image
Uncheck
Captured
Image

Print

Preview
Save as PDF
Export Review

Q@O @ B

Open List Mode

Open Review Mode

Open Report Mode

Open Export Mode

Select Captured image and add to the list to
print/export.

Deselect Captured image and remove from the
candidate list to print/export.

Print out the report for the Review.

Preview the report

Save the report as a PDF file.

Export Review data only without Video. Review
data is the own format of MiroView™, which

eIntro
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@ Send to PACS

Export EXMIF
@ Export
Export

Segment

@ Export Entire

contains Captured Images and Comments by
the user.

Send selected captured images to PACS system
via DICOM Sender

Export Captured Images as EXMIF
(eXchangeable Medical Information Format)
Export Captured Images as Image, Video, or
MiroVideo. MiroVideo is the own video format for
MiroView™.

Export segment as Video, MiroVideo

Export entire file as Video, MiroVideo

4- 30
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4.50verview - MiroView™ Viewer

4.5.1 Start MiroView™ Viewer

Double Click the 9 button to run MiroView™ Viewer. Open a
Image File (EXMIF-Exchangeable Medical Image Format data or
JPEG) via ‘File -> Open’ function.

® 0

PO

Wi v

Miroview
200
IntroMedic Co.
AFGHANISTAN
oz

os/12/1901
Male

Image Display
Title
Description
Study
Information

Image
Information
Findings

Diagnosis

Image Display Area (EXMIF or JPEG)

Title for the image in the Image Display
Description for the image in the Image Display
General Information (Software / Manufacturer /
Hospital Information), Patient Information
(Doctor, Patient Body Shape) and Study
Information (Doctor, Receiver, Capsule and
Procedure Information) for the image in the
Image Display

Creator Information and/or Finding Comments
for the image in the Image Display

Findings information the creator captured and
commented before for the image in the Image
Display.

Diagnosis information the creator captured and
commented on for the image in the Image
Display.

eIntro
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4.6 Performing Capsule Endoscopy

4.6.1 Initializing Receiver

B Connect the Receiver to the workstation via USB port.

B Run the MiroView™ Operator by double clicking the icon on the
desktop or from the Windows Start-up menu. Log in.

0 |Nurse

Password : | *****

v_' Remember your ID on this computer.

Receiver SN - 20080922

s |
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m  Click the m icon. The following message will appear.

=% Would you like to format the receiver?

i = y (This will delete all data on the receiver)

B Click ‘Yes’ to start the initializing process.

b I L
Receiver SN : 20080228

B After the initializing process is complete, the following message will
appear.
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B Click ‘OK’ and the Patient Information window will appear. Input
the patient information for each field.

B Click ‘Check Name’ button to input the patient name and then click
the ‘Check Doctor Name’ button to input the doctor name.

!:Casia Information

Case Information ‘

=D ‘ Check Patient

*Name ‘

=Gender  Unknown

*Birth date ‘zmn-u?-gu

*Procedure dale ‘2010-07-20

*Capsule type sB

*Capsule Sn

*Doctor in charge ‘

*Authorized User

*Authorized Group ‘

Height ‘U.UU

Weight ‘U.UU

Waist ‘U.DU

Body Shape ‘Shm

Insurance ‘

Group No ‘

Registered by ‘Admimstrator

Case Comment ‘

Recording ime Cance
2 Cancef

(The fields marked with * is required.)

B Click m to save the Patient Information to the Receiver. The
Receiver is now ready for the procedure.

@ NOTE The fields in the patient information are editable,
and additional fields can be added. This can be
accessed via Tools -> Preferences - Receiver
- Set > Add / Modify.
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4.6.2 Upload Data (MiroView™ Operator)

B Connect the Receiver to the workstation via USB port.

B Run the MiroView™ 2.0 Operator by double clicking the icon on
the desktop or from the Windows Start-up menu. Log in.

ID: [Nurse

Fassword | *****

v_' Remember your ID on this computer.

B After switching the Receiver on, enter the Receiver mode and
select the proper Receiver port to upload the patient file.

Receiver SN : 20071031

Uploaded
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B Click the button to start the Upload.

2 Uploading

.....

B After completing the Upload, the following message will appear.

MircView 2.0 Operator &J

l Upload complete,

4.6.3 Review (MiroView™ Client)

B Run MiroView™ Client by double clicking the icon on the desktop

or from the Windows Start-up menu. Log in.

ID - [Doctor

Password: [

| Remember vour ID on this computer.

¥

Local

*If you want to run the MiroView™ Client as Local Mode, click
‘Local’ button on the Log-in screen.
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B Select the Patient Video Data on the List Mode
- Select a patient video data to review from the List Mode and click

the . icon to enter the Review Mode.
- Check to see if another user is reviewing the patient file on the
Current User column in the List Mode.

TE W

Brocedire daie Doctor in charge

Honday, uly 19,2010 Medical Doctor [Admiristrator|

Wegnesday, July 15, 2009 Medical Doctor [F-C8]

Analyzed

Default

- If the patient file is eing reviewed by another ser, a message will
appear.
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B Review the Patient Video on the Review Mode

@ NOTE For efficient video playback the video is cached
locally in the server. During this buffering process,
the video may be reviewed.
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- Use the Range View and Normal View to find all the landmarks.

@ NOTE Click the landmark icon and select landmark type:
Esophagus, Gastric, Duodenum, lleoCecal, and
Cecal.
- After marking the necessary landmarks, play the video via the

Express mode and capture abnormalities and / or suspected disease

pathologies in the small bowel.
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@ NOTE The user can press ‘Enter’ key to capture the
image.

- To identify abnormalities and/or disease pathology more easily, use

the Image Enhancement function to adjust preferred image settings.

Click the . icon to open the Image Enhancement window.
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Composing the Report on the Report Mode

- After capturing images of suspected disease in the Review Mode

pathology, click the . icon to enter the Report Mode.

- Use the auto complete dictionary slide and choose available
disease pathology from the list.
- Completing the report:
1. Complete image comments for captured images (as required)
2. Complete the following tabs: Reason for referral; Procedure
Info & Findings; and Summary & Recommendations
3. After completing the report, enter the Export Mode to print out

the complete report and/or export MiroView™ 2.0 data.
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@ NOTE The Gl Dictionary tab and findings tab allow the
user to adjust the findings and the level of severity.
The user can use the GUI easily.

III CAUTION Do not detach and/or attach the Microphone
from/to the workstation while recording the audio
comment.

III CAUTION Sound Card Driver must be installed prior to using
the Recording function.

|I\ CAUTION Prior to recording the comments, close all the
applications using the Sound Card such as
music/video player.
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Print report, create file and export the Review on the Export
Mode.

- Select the images to select and click button to add the
selected captured images to the candidate list to export. (You

can remove the selected images from the candidate list using

the E button)

eIntro
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- Click the button to use export function. A window will
appear like below.

[:,_, Captured Images (jpa)
|v| Captured Image Videos (.avi)
|v| Review Data + MiroVideos (. mec)

|v| Save as PDF( pdf)

Export folder

File name
MiroView 2010_07_12

- Select the File Type to export and change the desired file

location on the Selected Folder and click the - button.
A window will appear with a progress bar.

Ci\Users..\MiroView 2010_07 18 [ 2010-07-21 152350 |

C:\Users...\MiroView 2010 07 18 [2010-07-21152350]

Cancel CancelAll

s\hgbae INTROMEDIC\DocumentsWMiroView ExporfWircView 2010_07_19[2010-07-21 1.. 17%
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- = The user can use the button for EXMIF, the button
for Segment Export (Video / Miro Video) and the button

for Export Case function.

@ NOTE Select the segments on the Timebar to export. If

no segment is selected, the &l button to export
segments would be disabled.

@ NOTE MiroVideo includes Reviews and selected
Segments so that the user can confirm the
contents and edit from ‘Open Case / Review file...’,
‘Import Case / Review file...” main menu.
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B Print Report and save the report as PDF on the Report Preview
- Click the icon to print reports and/or click the E icon to
save the report as PDF.

- Show report preview on the screen.

Capsule Endoscope Report

- The user can print out the report and save the report to PDF file
in this screen.

- If the user selects the 6 images or 9 images per page mode and
tries to print out, the message ‘If you proceed with the current
Layout mode, image comments may be omitted and not printed.
Please select another Layout Mode to include all comments in the

report.’ will appear.
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4.6.4 Image Atlas
m Atlas

Reference images are searchable by Capsule Endoscopy
Structured Terminology (CEST), Endoscopy 2005; 37: 951 - 959
(February 16, 2002 © Given Imaging Ltd.)

Atlas
My Atlas
Atlas + My Atlas

Import Atlas
Images from file
Export Atlas
Images to file(s)
Edit Information

Q ©® ©® ® O

Export Atlas
Image(s) to E-

Default Atlas Images

Atlas Images configured by the user

Show Atlas Images and My Atlas Images at
once.

Import Atlas Images from file; BMP, JPEG,
GIF, EMF, WMF, TIFF and PNG file format.
Export Atlas Images to file; BMP, JPEG, GIF,
EMF, WMF, TIFF and PNG file format.

Edit the Information for the selected Atlas
Image.

Export Atlas selected Atlas Image(s) and
sends it / them to another doctor via E-mail.

eSIntroMedic
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mail
Delete Atlas Delete the selected Atlas Image(s)
Image(s)
@ Print Atlas Print the selected Atlas image(s)
Image(s)
Save as PDF Save the selected Atlas Image(s) as PDF
@ Show/Hide Show / Hide Marks on the Atlas Image(s)
Marks
@ Search Search the Atlas Image
@ Comparison Show the Comparison Window
Window
@ Browser Area where to select the Category of the Atlas
Tab(Findings / Image to see.
Diagnosis)
@ Recent Images Images that the user saw on the Comparison

Window
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Image Show the Information for the Atlas Image
Information

@ Findings / Show the Findings / Diagnosis Information
Diagnosis

Atlas Thumbnail Search the Atlas Image
Area(2)

)
@ Comparison Show the Current Image and Comparison

Window Image at once.
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B Import Atlas Images from file(s)
MiroView™ allows the user to import image files for personal
purpose.

- Click the icon to open the ‘Open’ Browser to look for the files
to import.

., Open

€0 I

ks Name Datetaken  Tags ”

I Documents '.' ;'

] Recent Places v .

B Desktop 00001005 0. 00001005.0...
More 5

Folders v

>

Lymphangiectasia

Lymphoid Hyperplasia
pis

5B Ulcer

| Small Bowel Bleeding

|

1 Small Bowel Polyp
Small Bowel Tumor

Stomach Bleeding
Shrimtrrs

File name: *  |Allmage Files T
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- Select the file to import and click ‘Open’

Capture Information
= Additional Information
Menufacturer IntroMedic Co.. Ltd.
Software Name
Software Version 000
Contry Not Assigned

Hospital Name

= Gaseinformation
Procedure date 01/01/0100
Capsule Type Not Assigned
Capsule Version 000
Capsule Serial Number

Receiver Type Not Assigned
Receiver Version 0.0.0
Receiver Serial Number

Doctor Name:

MireCam@ Déctor Email

Title w Findings

Description

- Complete the ‘Title’, ‘Description’ and ‘Image Information’ fields and click
‘OK..
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4.7How to import MiroView™ 1.0 files

4.7.1 Preparing files for import

Run the MiroView™ 1.0
Export files by clicking ‘Export for MiroView Express’ function on
MiroView™ 1.0

Before using the Export to MiroView Express function, you must insert
DVD media to the DVD writer or connect the external hard disk or USB

flash memory to the workstation via USB port.

1. Select a patient file from the list to export to MiroView Express.

2. Execute ‘Export to MiroView Express..." on the main menu
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3. If the form, ‘Save As’ appears like below, select the location to export and

fill in the ‘File name’ field and click ‘Save’.

4. The window appears like below and if the function ends successfully you
will see the message, “Exporting has been completed.”

& Export for Reader
p—

LalaBlnidn ]
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4.7.2 Import MiroView 1.0 files
B Run the MiroView™ 2.0 Operator or MiroView™ 2.0 Client.

B Execute the 'Import Case / Review File... -> Import Case’ in the ‘List’

menu

Doctor in charge
WiroView Introtdecic Hadical Doctor [ Administrator]

Hiroview Introbtecic Medical Doctor{F-PCB]

Analyzed

Default
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B Select MiroView™ 1.0 files from the file extension drop-down box and

look for the file to upgrade

= Open ==
@Gv| ..« mdserver » Data » MiroView Data - | ‘a | | Search pel ‘
‘ Organ)

Favarite Links

Date modif.. Type Size

E' SR No items match your search.

%2 Recent Places
Ml Deskiop
M Computer
E; Pictures
m‘ Music
[® Recently Changed
E Searches
Public

Folders ~

File name:

B Look for the File with extension ‘.MiroCam’ and click ‘Open’

" Open ==
@Qaﬂ | = rndserver » Data » MiroView Data - | ‘?| |§egr9h Al

‘ Organize » Qg Vi

Favarite Links

Ei Docurments
% Recent Places
M Deskiop "

er.MiroCam

Name‘ Date modif... Type Size

M Computer
E: Pictures
m‘ Music
|4 Recently Changed
w Searches
Public

N Type: MIROCAM File
Size: 10.0 ME
Date modified: 2009-06-10 2= 1:01

Folders ~

Fie game| @ 01 Mirotam b [meoview 1 Fies ¢ MimCam) ~]

| gpml Carce!
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B Task Manager will appear and will proceed with importation of the file.

If the Doctor name on the file is not registered on the MiroView™ 2.0

Server, ‘Doctor in charge

registration process will start.

2 0848 T S Wt Caeed 0 st

¥ U0 IR WA ettt G 1 3 P

U0RH TS S o Akt sk |

At e 0 |

S W S S + il st |
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m If the Reviewer name on the file is not registrered on the MiroView™

2.0 Server, ‘Reviewer’ registration process will start.

n et mminster] - d
o et bt bt L= ax =]
i g

atmolisne st |

B Complete necessary fields and click ‘OK’.
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B Progress bar will appear.

= e = —— o) ax g
TR e @ 6% g
= s 52 =] aX %]

e — =y
B Upgrading MiroView™ 1.0 file to MiroView™ 2.0 file will be completed.

- q
e acame 142 UG smuamnazens W] & 4]
T Sodms2 4 71 015 up asas s et s i aX 7]
= E T Al b 1 e At it | b X 7]
0 0 S nfin G ) Aok | Al | - ax =}

Ty e
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5. USING MIROVIEW™ RTV

MiroView™ RTV, the application software for the MiroCam® System Real-
time Viewer, consist of a data transmission module that directly receives
the image data from the MiroCam® Receiver and an output module for

image display.
5.10verview

MiroView™ RTV software can be installed on any mobile platform. Click

the corresponding icon on the desktop to launch the MiroView™ RTV.

5.1.1 Basic Screen Layout

MiroV

@® Name / ID / Gender / Age
@ Start / Pause / Resume

® Main Display

Y@ Time Display

@ Patient Display patient name, ID, gender and age
Information

® Operation Change MiroView™ RTV operation status
Button between start, pause and resume.

® Main Display Display captured image.

@ Time Display Indicates the MiroCam® capsule endoscope

procedure time.
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5.1.2 Basic Mobile PC Layout

“SAMSUNG

@ USB Port USB Port for connect with MiroCam® Receiver
@ DC-Jack Connector for Mobile PC Charger
® Power Switch Mobile PC Power on switch.

&WARNING Only recharge the mobile PC batteries when MiroCam®
Receiver does not connect to the mobile PC.
&WARNING For safe use of mobile PC, please refer to mobile PC User

Manual.

eSIntroMedic



Using Wireless MiroView™ RTV Chapter 5

5.1.3 Recommended Hardware Specification

Operating System : Windows XP Professional
CPU : A110 800Mhz

Memory : DDR |l 1GByte(667MHz)

Display Adaptor : Windows Compatible

Hard Disk : Over 1GB

Monitor Resolution : 1024x600

Monitor Contrast : Windows Compatible

In compliance with IEC60950-1 or IEC60601-1
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5.2Using MiroView™ RTV

5.2.1 Before Using MiroView™ RTV

B The MiroView™ RTV software is pre-install on mobile PC

AWARNING Do not use MiroView™ RTV software and mobile PC before
upgrading the MiroCam® Receiver.

&WARNING Do not upgrade MiroCam® Receiver during the MiroCam®
capsule endoscopy procedure, it may result in loss if image

data.

B Connect the data cable for the Real-time Viewer to the MiroCam®
Receiver.

@ NOTE The data cable for MiroView™ RTV has no cover for the
USB port on the MiroCam® Receiver.

B Fallow the MiroCam® capsule endoscopy procedure.

@ NOTE For more information on the MiroCam® capsule endoscope
procedure, please refer to Chapter 3, Performing Capsule
Endoscopy.
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5.2.2 Starting MiroView™ RTV

B Switch on the mobile PC.

B Click the ﬁicon on the desktop to launch MiroView™ RTV.
B Connect the small side of the USB cable to the MiroCam®
Receiver.

B Connect the large side of the USB cable to the Mobile PC.

-

Click the button to start image display

Click the button to stop image display

Click the button to restart image display

Click the . button on the top-right to close the MiroView™ RTV.

@ NOTE Start, Pause, and Resume use the same button. The
function (Start, Pause or Resume) changes based upon the
status of MiroView™ RTV software.

m CAUTION MiroView™ RTV is not software for to be used for
diagnostic purposes. Use the MiroView™ software for
viewing the patient images for diagnostic purposes.

II‘ CAUTION Do not disconnect the MiroCam® Receiver while the RTV is
in use. If the MiroCam® Receiver is disconnected during
use, the software may need to be restarted.

@ NOTE [f an error message appears while using MiroView™ RTV,
reconnect the USB cable between MiroCam® Receiver and
Mobile PC
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5.2.3 After Using MiroView™ RTV

B Disconnect USB cable from MiroCam® Receiver and mobile PC.

B Continue MiroCam® capsule endoscope procedure.
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6. USING WIRELESS MIROVIEW™ RTV

Wireless MiroView™ RTV, the application software for the MiroCam®
System Real-time Viewer, consist of a data transmission module that
directly receives the image data from the MiroCam® Receiver and an
output module for image display. Wireless MiroView™ RTV receive image

data via Wi-Fi channel.

6.10verview

Wireless MiroView™ RTV software can be installed on I-OS 3 or I-OS 4
running on I-Pad / I-Phone / I-Pod Touch. Click the corresponding icon on

the desktop to launch the Wireless MiroView™ RTV.

6.1.1 Basic Screen Layout — I-Phone / I-Pod Touch

P P& 4:04 100% Gk
® ID / Name / Gender / A
ARSI |liroView RTV

@ Receiver Scan
20100923001 / Intromedic Test (3 )

(@ Main Display

@ Time Display

00:00:11
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@ Patient Display patient name, ID, gender and age
Information
® Receiver Show the available Receiver Access Points so
Scan Button that the user can choose to see the patient
image.
® Main Display Display captured image.
@ Time Display Indicates the MiroCam® capsule endoscope

procedure time.

6.1.2 Basic Screen Layout - I-Pad

iPad =

MiroCam RCV g @ Receiver Scan
IntroMedic_MR1100_S030

NAME:S.H.Kim

1D:20110507030
AGE:34 (MALE)

® ID / Name / Gender / Age

(@ Main Display

@ Time Display

00:15:09

@ NOTE !f turning the I-Pad upright as Portrait View, Receiver List
will disappear for the Main Display to be enlarged.

>4 eIntro



Using Wireless MiroView™ RTV Chapter 5

@ Patient Display patient name, ID, gender and age
Information
® Receiver Show the available Receiver Access Points so
Scan Button ~ that the user can choose to see the patient
image.
® Main Display Display captured image.
@ Time Display Indicates the MiroCam® capsule endoscope

procedure time.

6.1.3 Recommended Hardware Platform

B |-Phone 3G, 3GS, 4G
B |-Pod Touch 3G
B |-Pad
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6.2Using Wireless MiroView™ RTV

6.2.1 Network configuration for Wireless MiroView™ RTV

B The Wireless MiroView™ RTV software is pre-installed on I-OS 3/
I-OS 4 running on I-Phone, I-Pod Touch or |-Pad.

@ NOTE When the Wireless MiroView RTV run first, network
configuration for I-Phone and I-Pad is required.

B Fallow the MiroCam® capsule endoscopy procedure.
B Turn on the Wi-Fi switch on the MiroCam® Receiver System
during the Capsule Procedure.

@ NOTE For more information on the MiroCam® capsule endoscope
procedure, please refer to Chapter 3, Performing Capsule
Endoscopy.
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B Click the L‘Z icon on the desktop to launch MiroView™ RTV.

m Click the H button on the right-top to show the available
MiroCam® Receiver Access Points
ullolleh 3G 2= 4.04 100% .

MiroView RTV
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B If no available Receiver® Access Points are shown on the list, the
image will appear like below. Please make sure that the Wifi-
Swtich on the Receiver is turned on.

Laillolieh = 2= 4:05 1009 &=

MiroView RTV

HintraMadic

| OK |

B [f the MiroCam® Receiver Access Points are shown on the list.
Click the desirable AP (Access Point) to show the patient’'s image.

il olleh = 2= 4:10 1009, HEL

Cancel MiroCam RCV

IntroMedic_ MR1100_S023

& Channel : 3
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B At the first time to connect to the AP, IP setting is required as below
steps:

® Step 1. Press the Home Button on the I-Phone/I-Pad/I-Pod touch
to close the Wireless MiroView™ RTV Software.

App Store Stocks Tunes QRReader

of

Settinas Notes

TRHS

Dictionary Calendar Messages
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® Step3. Set the IP for the desirable AP. (Setup as Static; IP
Address : 192.168.3.200, Subnet Mask: 255.255.255.0)

il olleh = DX 5:26 100% =5
g Airplane Mode | | OFF
& wiFi intromedic >
k&) Notifications on >
Carrier olleh >
Sounds >
ﬁ Brightness >
g Wallpaper >

l @ General >

Lallolieh 3G 2% 5:26 100,

"semngs | Wi-Fi Networks

W Cow i)

Choose a Network...

‘ intromedic as @ ‘

v IntroMedic_MR110...

iptime-mic

] kd_241 &= © l
|

‘. Other... > :

| Ask to Join Networks m‘ |

Known networks will be joined
ik L

airks tinalhe B oas L

ara
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_milolleh 3G 2% 5:26 100% F&
“WI-Fi Netwo... 'IntroMedic_MR110...

| Forget this Network |

|I Auto-Join

IP Address

DHCP BootP

IP Address

Subnet Mask

Router

DNS

Lallolleh 3G 2% 5:27 100%
“Wi-Fi Neto... | IntroMedic_MR110...

o ccor [T

192.168.3.200 ‘

‘ IP Address

‘ Subnet Mask l 255.255.255.4 |

Router

B After completing the IP setting, close the setting window by clicking
the home button on the I-Phone/I-Pad/I-Pod touch and go back to

the desktop.
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Chapter 6 Using Wireless MiroView™ RTV

6.2.2 Running MiroView™ RTV

B Fallow the MiroCam® capsule endoscopy procedure.
B Turn on the Wi-Fi switch on the MiroCam® Receiver System
during the Capsule Procedure.

@ NOTE For more information on the MiroCam® capsule endoscope
procedure, please refer to Chapter 3, Performing Capsule
Endoscopy.
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Using Wireless MiroView™ RTV Chapter 5

B Click the H icon on the desktop to launch Wireless MiroView™
RTV.

B The Splash window will appear for a while and will disappear.

oullolieh 36 2% 5:44 100%

#introMedic

MiroView Real Time Viewer

COPYRIGHT 2010 BY IntroMedic. ALL RIGHTS RESERVED
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Chapter 6 Using Wireless MiroView™ RTV

B After the splash window disappears, the real time play will be
started automatically. (The number of receiver is one).

il olleh 3G 25 4:04 100% =k

MiroView RTV

20100323001 / Intromedic Test (30 / MAIL)

>

00:00:11

% If there are two or more Receiver AP is available, the
Receiver AP List window will be shown. Choose one to
continue as below:

Lullolleh = 2= 4:10 100% &

Cancel MiroCam RCV

IntroMedic_MR1100_5023

' Channel : 3

B After reviewing the real time play is completed, click the home
button to close.
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Using Wireless MiroView™ RTV Chapter 5

B To terminate the Software completely, double click the home button.
The menu will pop up like below.

J "
ot
Photos MiroView RT'

B Press the Wireless MiroView RTV icon for a while. The € mark
will appear.

'sﬂltmg\ Phatas MiroView RTV Phnne

eSIntroMedic 5-15



Chapter 6 Using Wireless MiroView™ RTV

B Click the @& icon, then the Wireless MiroView RTV will be
terminated completely.

II\ CAUTION Wireless MiroView™ RTV is not to be used for diagnostic
purposes. Use the MiroView™ software for viewing the
patient images for diagnostic purposes.

6.2.3 After Using Wireless MiroView™ RTV

B Turn off the Wi-Fi switch on the MiroCam® receiver system.
B Continue MiroCam® capsule endoscope procedure.
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Case Form Report

Trial ID : Version No. : 1.0 : 30/07/2007

CASE REPORT FORM

Subject No.: Subject Initials : Center No.:

Principal

Investigator

Center Name

Address

Telephone No.

Fax No.

E-mail

CONFIDENTIAL

eeIntro



Case Form Report

Trial ID : Version No. : 1.0 :
30/07/2007
Screening
Subject No.: Subject Initials : Center No.:

Date of Informed consent signed

D M M Y Y Y Y

Inclusion Criteria

Yes No N/A

1. Informed consent form voluntarily signed

2. Male / Female subject of age 19 years~70 years.

If there is one or more mark of ‘No’, you shall be contradicted for this clinical test.

CONFIDENTIAL
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Trial ID :

Case Form Report

Version No. : 1.0 : 30/07/2007

Screening

Subject No.: Subject Initials : Center No.:

Date of visit :

D M MY Y Y Y

Exclusion Criteria

No

N/A

Do you have a gastrointestinal disorder (suspected
malignantlesions or gastrointestinal obstructive disorders,
perforation, stenosis or fistula)?

2. Do you have a cardiovascular disorder (dysrhythemia, trouble
with cardiac conduction system, hypertension(high blood | [ | || |
pressure) or ischemic heart disease)?

3. Have you been diagnosed of cardiac insufficiency, angina l | | I
pectoris or cardiac arrest (heart attack) in recent 6 months?

4. Are you with (or implanted) medical devices such as cardiac | ] |
pacemaker or defibrillator?

5. Do you have a swallowing disorder? L] |

6. Do you have delayed gastric emptying or serious gastric | ] |

disorder?

7. Are you a pregnant or nursing woman, or a woman of child | Bl |
bearing potential?

8. Are you an infant or epileptic? Are you easily affected by | ] |
electronic waves?

9. Do you have several small bowel diverticulums ? L] |

10. Did you fail to obtain a voluntary agreement?

11.

Are you judged unqualified for this test by doctors or nurses?

If there is one or more mark of ‘Yes’, you shall be contradicted for this clinical test.

CONFIDENTIAL
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Case Form Report
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